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Στους γονείς μου Λεωνίδα και Βέλη!  

Χωρίς τη βοήθειά σας 

 τίποτα δεν θα ήταν εφικτό… 
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1. Εισαγωγή 
 
Βασικός στόχος αυτής της διπλωματικής είναι η παρουσίαση του συγχρόνου τρόπου 
σχεδιασμού και εκτέλεσης κατεργασιών για CNC φραίζες τριών αξόνων με τη βοήθεια του 
προγράμματος CAD/CAM Pro/Engineer. Παράλληλα με την παρουσίαση αυτή παρατίθενται 
και χρήσιμες πληροφορίες για προγράμματα, τα οποία παίζουν σημαντικό ρόλο στο 
σχεδιασμό αυτόν, όπως το πρόγραμμα προσομοίωσης κατεργασιών Vericut και το 
πρόγραμμα τελικής επεξεργασίας Pro/NC-GPost.  

Αρχικά γίνεται μια παρουσίαση των εργαλειομηχανών CNC, του κώδικα των 
εργαλειομηχανών και του τρόπου δημιουργίας του ενώ παρουσιάζονται και πληροφορίες 
που σχετίζονται με τα κοπτικά εργαλεία. 

Στη συνέχεια παρουσιάζεται ο τρόπος σχεδιασμού κατεργασιών στο Pro/Manufacture για 
φραίζες τριών αξόνων. Παράλληλα, παρατίθενται και σημαντικές πληροφορίες για τις 
τεχνολογικές παραμέτρους που παίζουν το σημαντικότερο ρόλο σε κάθε κατεργασία.  

Τέλος, παρουσιάζονται τέσσερα διαφορετικά παραδείγματα τεμαχίων, χρησιμοποιώντας τις 
κατεργασίες που κρίθηκαν σημαντικότερες. Εκτός της προσομοίωσης της κοπής των 
τεμαχίων πραγματοποιήθηκε και η ρεαλιστική κατεργασία τους, για να αντιμετωπιστεί τελικά 
ολοκληρωμένη η διαδικασία κατεργασίας με αυτόματο τρόπο από ένα σύστημα Cad/Cam. 
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2. Αριθμητικός έλεγχος και εργαλειομηχανές CNC  
 
2.1 Αριθμητικός έλεγχος εργαλειομηχανών  
 
Αριθμητικός έλεγχος εργαλειομηχανών είναι ο τύπος ελέγχου που χρησιμοποιεί αριθμητικές 
τιμές για την αναφορά στη θέση και την κίνηση των αξόνων της μηχανής, για τον ορισμό 
εργαλείων, στροφών ατράκτου κ.λπ.. Η έννοια «άξονας μηχανής» αναφέρεται σε ένα 
κινηματικό άξονα που αντιστοιχεί συνήθως σε γραμμική κίνηση, όπως η πρόωση του 
τραπεζιού μιας φραίζας, ή σε περιστροφική κίνηση, όπως η περιστροφή του διαιρέτη της 
φραίζας. Μία σειρά τέτοιων αριθμητικών τιμών αποτελεί ουσιαστικά το πρόγραμμα 
αριθμητικού ελέγχου. Τα σημερινά συστήματα ελέγχου CNC (Computer Numerical Control) 
χρησιμοποιούν επιπρόσθετα αριθμητικές τιμές και για λειτουργίες όπως ο μετασχηματισμός 
συστημάτων συντεταγμένων, η διαχείριση πινάκων δεδομένων, η αντιστάθμιση διαμέτρου 
και μήκους εργαλείου κ.λπ.. Αυτές, καθώς και επιπρόσθετες λειτουργίες γραφικών, 
επικοινωνίας με άλλους Η/Υ και περιφερειακά ,αντιδιαστέλλουν τον απλό αριθμητικό έλεγχο 
(NC) με αυτόν που βασίζεται σε ηλεκτρονικό υπολογιστή (CNC). Σήμερα πλέον δεν 
υφίσταται NC με την αρχική του έννοια, αλλά απλά CNC και αυτό εννοείται πλέον με τον όρο 
«αριθμητικός έλεγχος». 
 
Σε αντίθεση με τον παλαιότερο μηχανικό, πνευματικό ή υδραυλικό έλεγχο μηχανών και 
συσκευών, όπου ο αναπρογραμματισμός ήταν εξαιρετικά χρονοβόρος διότι γινόταν με 
μετατόπιση οριακών διακοπτών, βυσμάτων καλωδίων κ.λπ., αλλά και με τις πρώτες μονάδες 
αριθμητικού ελέγχου όπου η κύρια λειτουργία ήταν η μετατροπή αριθμητικών τιμών σε 
ηλεκτρικά σήματα, οι σημερινές μονάδες CNC εκτελούν σχετικά μεγάλης έκτασης 
επεξεργασία των δεδομένων, κάτι που τους προσθέτει λειτουργικότητα αλλά και 
πολυπλοκότητα. 
 
Τα κύρια στοιχεία εργαλειομηχανής αριθμητικού ελέγχου είναι τα εξής : 

• Οι άξονες της εργαλειομηχανής - συνδυασμός γραμμικών και περιστροφικών, όπου 
κάθε άξονας νοείται και με την κινηματική του έννοια, αλλά και σαν σύστημα 
μετάδοσης κίνησης, όπως επίσης και μέτρησης των στοιχείων αυτής της κίνησης 
(θέση, ταχύτητα, επιτάχυνση). 

• Το ηλεκτρονικό σύστημα ελέγχου το οποίο περιλαμβάνει συνήθως ένα αριθμό μικρο-
επεξεργαστών, RAM, ROM και ολοκληρωμένων κυκλωμάτων για την επεξεργασία και 
διαχείριση του προγράμματος καθώς και ηλεκτρονικά ισχύος για τον έλεγχο των 
αξόνων. 

• Το λογισμικό - λειτουργικό σύστημα το οποίο περιλαμβάνει παραμέτρους μηχανής, 
περιβάλλον προγραμματισμού, σταθερές ρουτίνες επιμέρους κατεργασιών, ρουτίνες 
διευκόλυνσης του προγραμματισμού της μονάδας ελέγχου, σύστημα ενδείξεων 
τρέχουσας κατάστασης, διαγνωστικά βλαβών κλπ. 

• Διάφορα περιφερειακά για την εισαγωγή του προγράμματος στη μηχανή, την 
εκτύπωση αρχείων και ενδεχόμενα την παρακολούθηση της λειτουργίας της 
εργαλειομηχανής. 
 

Το Σχήμα 2.1 παρουσιάζει διαγραμματικά τα παραπάνω στοιχεία. 
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Σχήμα 2.1: Κύρια στοιχεία συστήματος εργαλειομηχανής αριθμητικού ελέγχου. 
 
 
2.2 Πεδίο χρησιμοποίησης εργαλειομηχανών NC, CNC 
 
Σήμερα, όλες οι συμβατικές και μη συμβατικές μηχανουργικές κατεργασίες υποστηρίζονται 
από ψηφιακά καθοδηγούμενες εργαλειομηχανές NC και CNC. Το γεγονός αυτό έχει ως 
αποτέλεσμα, πολλές μεγάλες εταιρείες σε αρκετές χώρες του κόσμου με παράδοση στη 
μηχανουργική τεχνολογία, όπως είναι οι ΗΠΑ, η Γερμανία και η Ιαπωνία, να μην 
κατασκευάζουν πια συμβατικές εργαλειομηχανές, ήδη από την αρχή της δεκαετίας του ‘90. 
Μία από τις βασικές αιτίες για την εξέλιξη αυτή, είναι η αδυναμία των συμβατικών 
εργαλειομηχανών να πραγματοποιούν πολύπλοκες κατεργασίες με μεγάλες ταχύτητες. 
 
Ενώ όλες οι μηχανουργικές κατεργασίες, απλές ή σύνθετες, μπορεί να γίνουν από ψηφιακά 
καθοδηγούμενες εργαλειομηχανές, δεν συμβαίνει το ίδιο και με τις συμβατικές 
εργαλειομηχανές. Αυτό μπορεί να φανεί με τα παρακάτω απλά παραδείγματα : 
 
• Είναι γνωστό ότι οι ταχύτητες κοπής συνεχώς αυξάνουν. Σε αυτό βοηθούν τόσο η 

ανάπτυξη ανθεκτικότερων κοπτικών εργαλείων, όσο και η εξέλιξη των ίδιων των 
εργαλειομηχανών. Έτσι, οι άλλοτε εξωτικές ταχύτητες κοπής των 500 m/min θεωρούνται 
πια συμβατικές. Κοπή σε υψηλές ταχύτητες (High Speed Cutting, HSC) σημαίνει σήμερα 
ταχύτητες από 1500 έως 2000 m/min. Ακόμα και ο πιο έμπειρος μηχανουργός δεν 
μπορεί να καθοδηγήσει χειροκίνητα εργαλειομηχανές, σε ταχύτητες μεγαλύτερες από 
150 m/min. Μάλιστα, σε ταχύτητες μεγαλύτερες από 500 m/min είναι δύσκολο ακόμα και 
να παρακολουθήσει κανείς την κίνηση του κοπτικού εργαλείου.  

• Οι σημερινές μηχανικές διατάξεις είναι σύνθετες και αποτελούνται από τεμάχια με 
πολύπλοκη γεωμετρία. Πολλές φορές μάλιστα περιέχουν μεταλλικά εξαρτήματα με 
ανάγλυφες επιφάνειες, που είναι δύσκολη ακόμα και η μαθηματική τους περιγραφή. 
Όμως, ακόμα και η κατασκευή ενός σφαιρικού τμήματος σε συμβατικό τόρνο απαιτεί 
συνδυασμένες κινήσεις και στις δύο κατευθύνσεις κατεργασίας, ενώ η γεωμετρική 
ποιότητα είναι συνήθως από κακή έως μέτρια. Στη συμβατική φραίζα η κατασκευή μιας 
σφαιρικής διαμόρφωσης είναι ακατόρθωτη. Τέτοιες επιφάνειες είναι αδύνατο να 
κατασκευαστούν χωρίς τη χρήση ψηφιακά καθοδηγούμενων εργαλειομηχανών. Στο 
παρελθόν κατασκευάζονταν μόνο με χύτευση, αφού πρώτα έμπειροι τεχνίτες 
κατασκεύαζαν στο χέρι τα καλούπια, με πολύ μεγάλο, όμως, κόπο και χρόνο. Η 
κατασκευή τέτοιων καλουπιών είναι σήμερα απλή και φθηνή υπόθεση με χρήση ενός 
CNC κέντρου κατεργασίας (ψηφιακά καθοδηγούμενη φραίζα με δυνατότητα αυτόματης 
αλλαγής εργαλείου). 
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• Ολοένα και περισσότερο η δομή της γραμμής παραγωγής εντάσσεται στην παραγωγή 
των εργοστασίων, στο εξωτερικό αλλά και στην Ελλάδα. Οι γραμμές παραγωγής 
απαιτούν μεγάλες και συνεχόμενες παρτίδες πανομοιότυπων εξαρτημάτων, με μεγάλη 
διαστατική ακρίβεια και μικρό ποσοστό ελαττωματικών τεμαχίων. Η κατασκευή, λοιπόν, 
τέτοιων τεμαχίων απαιτεί γρήγορες κατεργασίες, με μεγάλη επαναληψιμότητα (δηλαδή 
μπορούν να επαναληφθούν ακριβώς οι ίδιες κατεργασίες, όσες φορές κι αν είναι 
επιθυμητό) και υψηλή ακρίβεια κατασκευής.  
 

 
2.3 Η εργαλειομηχανή Haas Mini Mill HE 
 

 
Σχήμα 2.2: Η εργαλειομηχανή Haas Mini Mill HE. 
 
Το κέντρο κατεργασίας Mini Mill της Haas, είναι ένα κέντρο κατεργασίας καθέτου τύπου με 
δυνατότητα κίνησης σε τρεις άξονες ΧΥΖ. Ο ελεγκτής είναι HAAS controller συμβατός με 
FANUC, 32 bit διπλός, ενώ παρέχεται η δυνατότητα γραφικής προσομοίωσης σε 
ενσωματωμένη οθόνη ή σε εξωτερικό Η.Υ. O χώρος κατεργασίας της μηχανής είναι 
περίκλειστος και υπάρχει αντλία ψυκτικού υγρού με αυτόματη λειτουργία. Τα τεχνικά 
χαρακτηριστικά της εργαλειομηχανής αυτής φαίνονται παρακάτω: 
 
Διαδρομές αξόνων 

• Στον άξονα Χ 406 mm 
• Στον άξονα Υ 305 mm 
• Στον άξονα Ζ 254 mm 

 
 
 
 
 
  



8 
 

Διαστάσεις Τράπεζας 
• Μήκος 914 mm 
• Πλάτος 305 mm 
• Μέγιστο βάρος στην τράπεζα 227 kg 
• Πλάτος αυλακώσεων (τύπου Τ) 15.875 mm 
• Απόσταση αυλακώσεων (τύπου Τ) 110 mm 
• Αριθμός αυλακώσεων (τύπου Τ) 3 

 
Άτρακτος 

• Taper Size #40 Taper 
• Μέγιστες στροφές 6000 rpm 
• Μέγιστη Ροπή 45 Nm @ 1200 rpm 
• Ισχύς κινητήρα ατράκτου 5.59 kw 
• Ισχύς κινητήρων αξόνων 2.24 kw 
• Ψύξη Πεπιεσμένος αέρας 

 
Προώσεις 

• Ταχείες προώσεις 15.2 m/min 
• Μέγιστη πρόωση κοπής 12.7 m/min 

 
Μύλος Κοπτικών 

• Χωρητικότητα 10 
• Μέγιστο βάρος κοπτικού 5.4 kg 
• Χρόνος αλλαγής κοπτικού 3.6 sec 

 
Ακρίβεια 

• Τοποθέτησης (±) 0.0051 mm 
• Επαναληψιμότητα (±) 0.0025 mm 

 
Γενικά 

• Άνοιγμα πόρτας 610 mm 
• Βάρος 1542 kg 
• Απαιτήσεις σε αέρα 113 lpm @ 6.9 bar 
• Απαιτήσεις σε ρεύμα 9 kVA; 208-240 VAC @ 30A 3-phase 
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3. Pro/Manufacture 
 
Το Pro/Manufacture είναι ένα υποσύστημα του Pro/Engineer το οποίο επιτρέπει τη 
δημιουργία και την εκτέλεση προγραμμάτων για μηχανές αριθμητικού ελέγχου, τη δημιουργία 
προγραμμάτων για την επιθεώρηση κομματιών καθώς και άλλες λειτουργίες που σχετίζονται 
και με άλλα υποσυστήματα του Pro/Engineer.  
 
Στην παρακάτω εικόνα φαίνονται τα βήματα κατασκευής τεμαχίων. 
 

 
Σχήμα 3.1: Βήματα κατασκευής τεμαχίων. 
 
Tο σχέδιο του κομματιού μαζί με το αρχικό τεμάχιο δίνουν το μοντέλο κατεργασίας που είναι 
μια αναπαράσταση του πως είναι το αντικείμενο πριν και μετά την κατεργασία. Σε αυτή τη 
συναρμολόγηση εάν προστεθεί η γεωμετρία των κοπτικών καθώς και ο χώρος εργασίας της 
μηχανής προκύπτει το περιβάλλον κατεργασίας. Στη συνέχεια ορίζεται μία λειτουργία, η 
οποία είναι μια σειρά από ακολουθίες αριθμητικού ελέγχου που πραγματοποιούνται μέσα σε 
ένα συγκεκριμένο χώρο εργασίας έχοντας υπόψιν ένα συγκεκριμένο σύστημα 
συντεταγμένων. Κάθε ακολουθία αριθμητικού ελέγχου, που ορίζεται σε μια λειτουργία 
περιλαμβάνει κάποια στοιχεία της γεωμετρίας του αντικειμένου και κάποιες παραμέτρους, οι 
οποίες ορίζουν τον τρόπο κίνησης του κοπτικού και την ταχύτητα του. 
 
Αφού οριστεί μια ακολουθία αριθμητικού ελέγχου μπορεί να εκτελεστεί μια προσομοίωση 
κοπής με το Vericut. Εάν η προσομοίωση έχει τα επιθυμητά αποτελέσματα μπορεί να 
αφαιρεθεί ο κατεργασμένος όγκος και να ορισθεί η επόμενη ακολουθία. Η τελική επεξεργασία 
των δεδομένων είναι μια διαδικασία κατά τη διάρκεια της οποίας το αρχείο θέσης του 
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κοπτικού μετατρέπεται σε αρχείο με κώδικα κατανοητό στην μηχανή, με βάση τις ρυθμίσεις 
που έχουν γίνει στο γραφικό περιβάλλον του τελικού επεξεργαστή. Εάν το αποτέλεσμα της 
τελικής επεξεργασίας δεν ταιριάζει απόλυτα με αυτό που απαιτεί η μηχανή τότε είναι 
απαραίτητο να γίνει επαναπροσδιορισμός των ρυθμίσεων του τελικού επεξεργαστή. Εάν το 
αποτέλεσμα ταιριάζει, μεταφέρεται στη μηχανή με USB. Από την στιγμή που έχει αποσταλεί 
το πρόγραμμα στην μηχανή αριθμητικού ελέγχου, μπορεί να πραγματοποιηθεί η κατεργασία 
του κομματιού.  
 
Tο Pro/Manufacture για φραίζα διαθέτει 14 διαφορετικά είδη ακολουθιών οι οποίες είναι: 

• Η ακολουθία Volume αναφέρεται σε κατεργασία ενός συγκεκριμένου όγκου ανοιχτού 
ή κλειστού ο οποίος αφαιρείται με διαδοχικά παράλληλα περάσματα 2.5 αξόνων. 

• Η ακολουθία Local Mill κατεργάζεται κάποιο όγκο, ο οποίος έχει απομείνει από μια 
προηγουμένη κατεργασία. Η κατεργασία αυτή γίνεται συνήθως με κοπτικό μικρότερης 
διαμέτρου. 

• Η ακολουθία Surface Mill χρησιμοποιείται για την κατεργασία κάποιας επιφάνειας με 
2.5-5 άξονες. 

• Η ακολουθία Face αναφέρεται στην κατεργασία της άνω επιφάνειας του αντικειμένου 
με διαδοχικά περάσματα 2.5 αξόνων. 

• Η ακολουθία Profile αναφέρεται στην κατεργασία ενός μέρους ή ολόκληρης της 
περιφερείας ενός αντικειμένου με διαδοχικά περάσματα 2.5-5 αξόνων. 

• Η ακολουθία Pocketing είναι μια ακολουθία που έχει ως σκοπό την αποπεράτωση 
μιας κοιλότητας κατεργάζοντας πρώτα το προφίλ της κοιλότητας και στην συνέχεια 
την κάτω επιφάνεια της. 

• Η ακολουθία Trajectory έχει ως σκοπό την κατεργασία του όγκου του αντικειμένου 
που βρίσκεται πάνω σε μια τροχιά. 

• Η ακολουθία Holemaking έχει ως σκοπό την δημιουργία και κατεργασία οπών πάνω 
σε κάποια από τις επιφάνειες του αντικειμένου. 

• Η ακολουθία Thread έχει ως σκοπό την δημιουργία σπειρωμάτων τόσο σε 
εσωτερικές όσο και σε εξωτερικές κυλινδρικές επιφάνειες. 

• Η ακολουθία Engraving έχει ως σκοπό την χάραξη. 
• Η ακολουθία Plunge έχει δημιουργηθεί για την εκχόνδριση κοιλοτήτων μεγάλου 

βάθους με διαδοχικά βυθίσματα του κοπτικού μέσα στο όγκο του κομματιού. 
• Οι ακολουθίες Roughing, Re-Roughing και Finishing αναφέρονται στην εκχόνδριση 

ή αποπεράτωση συγκεκριμένων περιοχών του αντικειμένου με κατεργασία υψηλών 
ταχυτήτων. 

 
Από τις παραπάνω ακολουθίες οι Local Mill, Pocketing, Thread, Engraving, Plunge και 
Re-Roughing δεν περιγράφονται εκτενώς αφού δε χρησιμοποιούνται συχνά σε 
κατεργασίες ή μπορούν να αντικατασταθούν με κάποιες από τις υπόλοιπες. 
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3.1 Ακολουθία κατεργασίας όγκου (Volume Sequence) 
 

Η ακολουθία κατεργασίας όγκου (σχήμα 3.2) μπορεί να αφαιρέσει υλικό μέσα σε ένα 
συγκεκριμένο όγκο κόβοντας παράλληλα στην επιφάνεια επιστροφής. Η κατεργασία μπορεί 
να πραγματοποιηθεί με εκχόνδριση ή αποπεράτωση του όγκου, ή συνδυασμό των δύο. 
Υπάρχουν δύο τρόποι για την αφαίρεση του όγκου: ο σχεδιασμός ενός παραθύρου μέσα στο 
οποίο θα γίνει η κατεργασία και η επιλογή του. Στην δεύτερη περίπτωση οι εναλλακτικές είναι 
η σχεδίαση του όγκου ή η επιλογή του μέσω επιφανειών. 
 

 
Σχήμα 3.2: Παράδειγμα κατεργασίας όγκου. 
 
Οι σημαντικότερες παράμετροι στην κατεργασία όγκου είναι οι εξής: 

• Rough option: Ελέγχει αν δημιουργείται κατεργασία εκχόνδρισης ή αποπεράτωσης ή 
συνδυασμού τους. 

• Scan type: Ελέγχει τον τρόπο που κινείται το κοπτικό πάνω στην επιφάνεια. 
• Cut angle: Η γωνία κοπής σε σχέση με το σύστημα συντεταγμένων της ακολουθίας. 
• Step over: Η απόσταση ανάμεσα στα περάσματα. 
• Number of passes: Ο αριθμός των περασμάτων πάνω στην επιφάνεια. 
• Tool overlap: Η επικάλυψη της πορείας του κοπτικού κατά την κίνησή του. 
• Step over adjust: Ρύθμιση της παραμέτρου step over για πλήρη κάλυψη της 

επιφάνειας κατεργασίας. 
• Step depth: Το πάχος του υλικού που κατεργάζεται κάθε φορά το κοπτικό εργαλείο. 
• Wall scallop hgt: Ελέγχει το βάθος κοπής για τεμάχια υπό γωνία. 
• Min step depth: Διευκρινίζει το ελάχιστο επιτρεπτό βάθος κοπής. 
• Rough stock allow: Ελέγχει το πάχος του ακατέργαστου υλικού για τα περάσματα 

εκχόνδρισης. 
• Prof stock allow: Ελέγχει το πάχος του ακατέργαστου υλικού για τα περάσματα 

αποπεράτωσης. 
• Bottom stock allow: Το πάχος του υλικού που μένει ακατέργαστο, ώστε να 

κατεργαστεί σε επόμενο στάδιο. 
• Cut feed: Πρόωση κοπής. 
• Spindle speed: Ταχύτητα περιστροφής της ατράκτου. 
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3.2 Ακολουθία κατεργασίας προσώπου (Face Sequence) 
 

Η ακολουθία κατεργασίας προσώπου (σχήμα 3.3) μπορεί να αφαιρέσει υλικό από μία 
επιφάνεια παράλληλη στην άνω επιφάνεια του τεμαχίου (επίπεδο ΧΥ). Το κοπτικό εργαλείο 
εκτελεί διαδοχικά περάσματα ανάλογα με το βάθος κοπής. Οποιοδήποτε εσωτερικό 
περίγραμμα παραλείπεται. Η επιλογή του όγκου προς κατεργασία γίνεται είτε επιλέγοντας 
μία επιφάνεια του μοντέλου, είτε κατασκευάζοντας τον όγκο με κάποιο feature του 
Pro/Engineer. 

 
Σχήμα 3.3: Παράδειγμα κατεργασίας προσώπου. 
 
Οι σημαντικότερες παράμετροι στην κατεργασία προσώπου είναι οι εξής: 

• One pass offset: Ορίζεται η απόκλιση του κέντρου του κοπτικού από τη μέση του 
δοκιμίου, για ένα πέρασμα. 

• Initial edge offset: Ορίζεται η απόκλιση του κέντρου του κοπτικού από την ακμή 
αρχής. 

• Final edge offset: Ορίζεται η απόκλιση του κέντρου του κοπτικού από την ακμή 
τέλους. 

• Approach distance: Ελέγχει την επιπλέον απόσταση του κοπτικού από την αρχή 
του τεμαχίου στο πρώτο πέρασμα. 

• Exit distance: Ελέγχει την επιπλέον απόσταση του κοπτικού από την αρχή του 
τεμαχίου στο τελευταίο πέρασμα. 

• Start over travel: Ελέγχει την απομάκρυνση του κοπτικού από το τεμάχιο στην αρχή 
κάθε περάσματος. 

• End over travel: Ελέγχει την απομάκρυνση του κοπτικού από το τεμάχιο στο τέλος 
κάθε περάσματος. 

• Trim to work piece: Ελέγχει αν η πορεία του κοπτικού περιορίζεται στο προς 
κατεργασία κομμάτι. 

• Clear Dist: Ορίζεται η απόσταση από z=0, στην οποία οδηγείται το κοπτικό μετά το 
τέλος της κατεργασίας. 

• Καθώς και οι Cut feed, Spindle speed, Scan type, Cut angle, Step over, Number of 
passes, Tool overlap, Step over adjust, Step depth και Bottom stock allow, οι οποίες 
έχουν παρουσιαστεί στην ακολουθία κατεργασίας όγκου. 
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3.3 Ακολουθία κατεργασίας περιγράμματος (Profile Sequence) 
 
Η ακολουθία κατεργασίας περιγράμματος (σχήμα 3.4) αφαιρεί υλικό από την περιφέρεια του 
αντικειμένου. Το κοπτικό εργαλείο κινείται πάνω σε αυτή αλλά πρέπει να υπάρχει αρκετός 
χώρος για την προσέγγιση και την απομάκρυνσή του από το τεμάχιο.  
 

 
Σχήμα 3.4: Παράδειγμα κατεργασίας περιγράμματος. 
 
Οι σημαντικότερες παράμετροι στην κατεργασία περιγράμματος είναι οι εξής: 

• Axis shift: Ορίζεται η απόσταση θετική ή αρνητική από την κάτω επιφάνεια του 
αντικειμένου ως την κάτω επιφάνεια του κοπτικού. 

• Num prof passes: Ορίζει τον αριθμό ακτινικών περασμάτων σε κάθε βάθος. 
• Prof increment: Ορίζει την οριζόντια απόσταση ανάμεσα στα περάσματα. 
• Cutcom: Ενεργοποιεί ή απενεργοποιεί την αντιστάθμιση των κοπτικών. 
• Lead in: Το κοπτικό εισέρχεται στο τεμάχιο με εφαπτομενικό τόξο. 
• Lead out: Το κοπτικό εξέρχεται από το τεμάχιο με εφαπτομενικό τόξο. 
• Lead radius: Η τιμή της ακτίνας για το εφαπτομενικό τόξο των δύο προηγούμενων 

παραμέτρων. 
• Normal lead step: Η γραμμική απόσταση του κανονικού τμήματος μιας lead in ή lead 

out κίνησης. 
• Tangent lead step:  Η γραμμική απόσταση του εφαπτομενικού τμήματος μιας lead in 

ή lead out κίνησης. 
• Overtravel distance: Το μήκος της επικάλυψης του κοπτικού κατά το lead in και το 

lead out. 
• Καθώς και οι Cut feed, Spindle speed, Step depth, Prof stock allow, Approach 

distance και Exit distance, οι οποίες έχουν παρουσιαστεί στις προηγούμενες 
ακολουθίες κατεργασιών. 

 
 

3.4 Ακολουθία κατεργασίας διάτρησης (Holemaking Sequence) 
 
Η ακολουθία κατεργασίας διάτρησης (σχήμα 3.5) δημιουργεί ή κατεργάζεται οπές σε κάποια 
επιφάνεια του τεμαχίου. Αρχικά επιλέγεται το είδος του κύκλου κατεργασίας που θα 
ακολουθήσει, οι παράμετροί του, καθώς και οι άξονες και τα βάθη των οπών. 
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Σχήμα 3.5: Παράδειγμα κατεργασίας διάτρησης. 
 
Οι κύκλοι κατεργασίας που μπορούν να εκτελεστούν είναι: 

• Drill: Διάνοιξη οπής από ένα κοπτικό 
• Face: Δημιουργία ενός κύκλου κατεργασίας για την διασφάλιση της ομαλής 

επιφάνειας στο κάτω μέρος της οπής 
• Bore: Αναφέρεται στην διάνοιξη της τελικής οπής με μεγάλη ακρίβεια. 
• Countersink: Αναφέρεται στην διεύρυνση της αρχής της οπής με την χρήση ενός 

εργαλείου κατάλληλα διαμορφωμένου ώστε να δημιουργήσει μία λοξοτομή στην ακμή 
της οπής. 

• Τap: Αναφέρεται στην δημιουργία σπειρώματος σε μια ήδη υπάρχουσα οπή. 
• Ream: Αναφέρεται στην αποπεράτωση μιας οπής με μεγάλη ακρίβεια. 

 
Οι σημαντικότερες παράμετροι στην κατεργασία διάτρησης είναι οι εξής: 

• Breakout distance: Η παράμετρος αυτή φανερώνει την απόσταση που πρέπει να 
διανύσει το κοπτικό ώστε να έχουμε μια διαμπερή οπή,  δεδομένης της κωνικότητας 
του κοπτικού 

• Peck depth: Το βήμα κοπής ελέγχει το βάθος κοπής για την διάνοιξη οπών.   
• Rapto dist: Επιτρέπει την κίνηση του κοπτικού με ταχεία πρόωση ακόμα και κάτω 

από την απόσταση ασφαλείας. 
• Καθώς και οι Cut feed, Spindle speed, Scan type και Clear dist, οι οποίες έχουν 

παρουσιαστεί στις προηγούμενες ακολουθίες κατεργασιών. 
 
 

3.5 Ακολουθία κατεργασίας τροχιάς (Trajectory Sequence) 
 
Η ακολουθία κατεργασίας τροχιάς (σχήμα 3.6) επιτρέπει σε ένα εργαλείο να σαρώσει 
οποιαδήποτε καθορισμένη από το χρήστη τροχιά. Μπορεί να χρησιμοποιηθεί για 
κατεργασίες δημιουργίας αυλακώσεων και λοξοτομής ακμών. Ο χρήστης πρέπει να επιλέξει 
ανάμεσα σε σχεδίαση της τροχιάς, χρήση των ακμών του μοντέλου, χρήση των datum curves 
ή επιφανειών, καθώς και τις παραμέτρους της κατεργασίας.  
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Σχήμα 3.6: Παράδειγμα κατεργασίας τροχιάς. 
 
Οι σημαντικότερες παράμετροι στην  κατεργασία τροχιάς είναι οι εξής: 

• Number cuts: Υπολογισμός του βάθους κοπής χρησιμοποιώντας τον αριθμό των 
κοπών. 

• Καθώς και οι Cut feed, Spindle speed, Step depth, Num prof passes, Prof increment 
και Cutcom, οι οποίες έχουν παρουσιαστεί στις προηγούμενες ακολουθίες 
κατεργασιών. 
 

3.6 Ακολουθία κατεργασίας επιφάνειας (Surface Mill Sequence) 
 
Η ακολουθία κατεργασίας επιφάνειας (σχήμα 3.7) επιτρέπει στο χρήστη να κατεργαστεί 
περιγεγραμμένες και οριζόντιες επιφάνειες.  
 

 
Σχήμα 3.7: Παράδειγμα κατεργασίας επιφάνειας. 
 
Υπάρχουν τέσσερεις στρατηγικές κίνησης του κοπτικού για την κατεργασία της επιφάνειας, οι 
οποίες είναι: 

• Straight cut: Κατεργασία της επιφάνειας με μια σειρά ευθύγραμμων κινήσεων. 
• From surface isoline: Κατεργασία της επιφάνειας ακολουθώντας τις ισοϋψείς 

καμπύλες σε κάθε κατεύθυνση. 
• Cut line: Κατεργασία της επιφάνειας ορίζοντας την πρώτη, την τελευταία και κάποιες 

ενδιάμεσες τροχιές κατεργασίας.  
• Projected cuts: Κατεργασία της επιφάνειας προβάλλοντας το περίγραμμά της στην 

επιφάνεια επιστροφής του κοπτικού, δημιουργώντας μία επίπεδη τροχιά και 
προβάλλοντάς την και πάλι στην αρχική επιφάνεια.   
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Οι σημαντικότερες παράμετροι στην  κατεργασία επιφάνειας είναι οι εξής: 

• Offset increment: Για την στρατηγική κατεργασίας Cut line είναι το βήμα στο βάθος 
κοπής για πολλαπλά περάσματα. 

• Καθώς και οι Cut feed, Spindle speed, Scan type, Cut angle, Step over, Number of 
passes, Tool overlap, Step over adjust, Prof stock allow, Scallop hgt και Number 
cuts,οι οποίες έχουν παρουσιαστεί στις προηγούμενες ακολουθίες κατεργασιών. 
 

3.7 Ακολουθίες κατεργασίας εκχόνδρισης και αποπεράτωσης (Roughing 
and Finishing Sequences) 

 
Η  κατεργασία εκχόνδρισης (σχήμα 3.8) είναι παρόμοια με την ακολουθία κατεργασίας όγκου 
και χρησιμοποιείται κυρίως στην υψηλής ταχύτητας κατεργασία καλουπιών και ιδιαίτερα στην 
κατεργασία εισηγμένων γεωμετριών από άλλα συστήματα CAD. 

 
Σχήμα 3.8: Παράδειγμα κατεργασίας εκχόνδρισης. 
 
Η κατεργασία αποπεράτωσης (σχήμα 3.9) μπορεί να χρησιμοποιηθεί για κατεργασία αντικει-
μένων μετά την κατεργασία εκχόνδρισης. 

 
Σχήμα 3.9: Παράδειγμα κατεργασίας αποπεράτωσης. 
 
Οι σημαντικότερες παράμετροι στην  κατεργασία εκχόνδρισης είναι οι εξής: 

• Max step depth: Διευκρινίζει το μέγιστο επιτρεπτό βάθος κοπής. 
• Καθώς και οι Cut feed, Spindle speed, Step over, Rough stock allow, και Clear dist, οι 

οποίες έχουν παρουσιαστεί στις προηγούμενες ακολουθίες κατεργασιών. 
Οι σημαντικότερες παράμετροι στην  κατεργασία αποπεράτωσης είναι οι εξής: 

• Slope angle: Προσδιορίζει τη γωνία που χωρίζει τις επιφάνειες για κατεργασία, σε 
οριζόντιες και κάθετες.  

• Lace option: Προσδιορίζει τη μέθοδο κατεργασίας. 
• Καθώς και οι Cut feed, Spindle speed, Step over, Scallop hgt και Clear dist ,οι οποίες 

έχουν παρουσιαστεί στις προηγούμενες ακολουθίες κατεργασιών. 
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4. Διαδικασία κατασκευής τεμαχίων 
 
Μετά την ανάπτυξη των ακολουθιών του προγράμματος, παρουσιάζεται η διαδικασία 
μοντελοποίησης τεσσάρων τεμαχίων διαφόρων γεωμετριών. Τα αντικείμενα αυτά 
παρουσιάζονται στο σχήμα 4.1.  
 

 
 
Σχήμα 4.1: Τελικά κομμάτια που μοντελοποιήθηκαν. 
 
4.1 Πρώτο Τεμάχιο  
 
Αρχικά δημιουργείται το μοντέλο κατεργασίας, το οποίο αποτελείται από το αρχικό και το 
τελικό τεμάχιο. Το τελικό τεμάχιο έχει σχεδιαστεί στο Pro-Engineer (σχήμα 4.2).  
 

 
Σχήμα 4.2: Πρότυπο τεμάχιο 1. 
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Το αρχικό τεμάχιο θα κατασκευαστεί πατώντας File→ New→ Assembly→ Nc Model→ 
Create Stock. Στο παράθυρο που θα εμφανιστεί, εισάγεται η περίσσεια υλικού σε κάθε 
διάσταση του ακατέργαστου κομματιού, όπως φαίνεται παρακάτω:  
 

 
Σχήμα 4.3: Περίσσεια υλικού σε κάθε διάσταση. 
 
Στο σχήμα 4.4 φαίνεται το τελικό μοντέλο κατεργασίας. 
 

 
Σχήμα 4.4: Τελικό μοντέλο κατεργασίας τεμαχίου 1. 
 
Στη συνέχεια δημιουργείται το περιβάλλον κατεργασιών επιλέγοντας File→ New→ 
Manufacturing→ NC Assembly και εισάγεται το μοντέλο κατεργασίας πατώντας Mfg model→ 
Assemble→ Gen Assem, στο οποίο ορίζεται και σύστημα συντεταγμένων. 
 
Τώρα μπορεί να οριστεί μία νέα λειτουργία επιλέγοντας Mfg Setup (σχήμα 4.5). Δηλώνεται 
ως Machine Zero το σύστημα συντεταγμένων του τεμαχίου και η  επιφάνεια επιστροφής 
(retract surface) επιλέγεται κατά μήκος του άξονα z με βάθος 5. Στη συνέχεια ορίζεται μία νέα 
μηχανή αριθμητικού ελέγχου,  πατώντας το εικονίδιο δεξιά του NC Machine.  
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Σχήμα 4.5: Ορισμός νέας λειτουργίας. 
 
Στο παράθυρο που εμφανίζεται (σχήμα 4.6) εισάγεται το όνομα της μηχανής (Haas Mini Mill), 
το είδος της (Mill) και ο αριθμός των αξόνων της (3). 
 

 
Σχήμα 4.6: Ορισμός νέας μηχανής. 
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Στο tab Output πατώντας το pprint επιλέγει ο χρήστης ποιες πληροφορίες θα εμφανίζονται 
στον τελικό G κώδικα. Στη συγκεκριμένη περίπτωση έχουν επιλεχθεί τα part name, date time, 
nc sequence name, spindle speed και cut federate and units. Στο tab Spindle ορίζεται η 
μέγιστη ταχύτητα περιστροφής της ατράκτου (maximum speed) στις 6000 rpm, στο Feed η 
ταχεία μετακίνηση (rapid traverse) σε mm/min και στο Cutting tools ο χρόνος αλλαγής 
κοπτικού (tool change time) στα 6 sec. Έτσι ολοκληρώνεται η δημιουργία της λειτουργίας. 
 
Το επόμενο βήμα είναι η δημιουργία της λίστας των κοπτικών που θα χρησιμοποιηθούν, 
πατώντας Mfg Setup→ Tooling→ Haas_Mini_Mill. Κατασκευάζεται ένα κοπτικό όπως 
φαίνεται στο σχήμα 4.7. 
 

 

 
 

Σχήμα 4.7: Ορισμός κοπτικών εργαλείων. 
 
Σε αυτό το σημείο μπορεί να αρχίσει η εικονική κατεργασία του τεμαχίου, αφαιρώντας την 
περίσσεια υλικού που βρίσκεται στο άνω μέρος του. Για τη δημιουργία της ακολουθίας 
αριθμητικού ελέγχου επιλέγεται στο Menu Manager η εξής διαδρομή Machining→ Nc 
Sequence→ Face → Done. Στο μενού που εμφανίζεται, ο χρήστης διαλέγει το Name εκτός 
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των προεπιλεγμένων, το οποίο συμπληρώνει στο κάτω μέρος του βασικού παραθύρου 
(Face_1).  
 
Στη συνέχεια ανοίγει το παράθυρο του σχήματος 4.7, στο οποίο επιλέγεται το κοπτικό 
εργαλείο που θα χρησιμοποιηθεί στην κατεργασία. Το επόμενο βήμα είναι ο ορισμός των 
παραμέτρων της κατεργασίας, ο οποίος γίνεται πατώντας Set στο Model Tree. Εκτός των 
παραμέτρων του σχήματος 4.8 πρέπει να επιλεγεί «Yes» στο Trim to workpiece, που 
εμφανίζεται πατώντας Advanced.  
 

 
Σχήμα 4.8: Τιμές των παραμέτρων της πρώτης κατεργασίας προσώπου. 
 
Τέλος πρέπει να επιλεχθεί η επιφάνεια κατεργασίας, επιλέγοντας Model→ Done, την πάνω 
επιφάνεια του τεμαχίου και Done. 
 
Μετά το τέλος της κατεργασίας, μπορεί ο χρήστης να δει την πορεία που ακολουθεί το 
κοπτικό για αποφυγή λαθών. Αυτό γίνεται επιλέγοντας Play path→ Screen play και το 
πλήκτρο play (σχήμα 4.9).  Η πορεία του κοπτικού φαίνεται στο σχήμα 4.10.  
 
Εκτός της παραπάνω επιλογής, υπάρχει η δυνατότητα προσομοίωσης της κατεργασίας 
χρησιμοποιώντας το Vericut, επιλέγοντας Nc Check αντί του Screen play.  
 
Σε αυτό το σημείο ολοκληρώνεται η κατεργασία πατώντας Done Seq. 
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Σχήμα 4.9: Μενού για την πορεία του κοπτικού. 
 

 
Σχήμα 4.10: Πορεία κοπτικού για την πρώτη κατεργασία προσώπου. 
 
Στη συνέχεια κατασκευάζεται άλλη μία κατεργασία προσώπου για την αποπεράτωση της 
επιφάνειας, με όνομα Face_2, το ίδιο κοπτικό και για τις παραμέτρους επιλέγεται Use prev→ 
Set. Με αυτό τον τρόπο χρησιμοποιούνται οι προηγούμενες ρυθμίσεις αλλάζοντας μόνο τις 
απαραίτητες (σχήμα 4.11). Επιλέγεται πάλι η επιφάνεια κατεργασίας και ελέγχεται η 
διαδικασία με Screen play (σχήμα 4.12).  
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Σχήμα 4.11: Τιμές των παραμέτρων της δεύτερης κατεργασίας προσώπου. 
 

 
Σχήμα 4.12: Πορεία κοπτικού για τη δεύτερη κατεργασία προσώπου. 
 
Μετά το τέλος της κατεργασίας μπορεί να αφαιρεθεί ο κατεργασμένος όγκος, επιλέγοντας 
Machining→ Matrl Remove→ Face_2→ Automatic→ Done→ Auto Add→ Ok→ Done. Στο 
σχήμα 4.13 φαίνεται το τεμάχιο μετά από την αφαίρεση του όγκου. 
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Σχήμα 4.13: Τεμάχιο μετά το τέλος των κατεργασιών προσώπου. 
 
Η επόμενη ακολουθία είναι κατεργασία περιγράμματος. Για την δημιουργία της επιλέγεται 
Machining→ Nc Sequence→ New Sequence→ Profile→ Done. Στο μενού που εμφανίζεται ο 
χρήστης επιλέγει και πάλι το Name (Profile_1) εκτός των προεπιλεγμένων. Πατώντας Set 
ορίζονται οι παράμετροι της κατεργασίας (σχήμα 4.14). Εκτός των παραμέτρων του 
σχήματος 4.14 συμπληρώνονται στο Advanced το Num prof passes 4 και το Prof increment 
5. 

 
Σχήμα 4.14: Τιμές των παραμέτρων της πρώτης κατεργασίας περιγράμματος.  
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Σχήμα 4.15: Πορεία κοπτικού για την πρώτη κατεργασία περιγράμματος. 
 
Στη συνέχεια κατασκευάζεται άλλη μία κατεργασία περιγράμματος για την αποπεράτωση της 
επιφάνειας, με όνομα Profile_2, το ίδιο κοπτικό και για τις παραμέτρους επιλέγεται Use 
prev→ Set. Με αυτό τον τρόπο χρησιμοποιούνται οι προηγούμενες ρυθμίσεις αλλάζοντας 
μόνο αυτές που φαίνονται στο σχήμα 4.16 καθώς και το Num prof passes, το οποίο γίνεται 1. 
Επιλέγεται πάλι η επιφάνεια κατεργασίας και ελέγχεται η διαδικασία με Screen play (σχήμα 
4.17).  

 
Σχήμα 4.16: Τιμές των παραμέτρων της δεύτερης κατεργασίας περιγράμματος.  
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Σχήμα 4.17: Πορεία κοπτικού για τη δεύτερη κατεργασία περιγράμματος. 
 
Μετά το τέλος της κατεργασίας αφαιρείται πάλι ο κατεργασμένος όγκος, δημιουργώντας τον 
με Construct και Extrude. Στο σχήμα 4.18 φαίνεται το τελικό τεμάχιο στο πρόγραμμα 
προσομοίωσης Vericut. 
 
Μετά τον σχεδιασμό του τεμαχίου πρέπει να γίνει η μεταγλώττιση του αρχείου θέσης του 
κοπτικού σε μια γλωσσά που αντιλαμβάνεται η εκάστοτε μηχανή αριθμητικού ελέγχου. Για να 
γίνει σωστά η μεταγλώττιση θα πρέπει ο post processor να είναι ρυθμισμένος κατάλληλα 
ώστε το εξαγόμενό του να είναι ακριβώς αυτό που απαιτείται από τη μηχανή. 
Αρχικά πρέπει να δημιουργηθεί το αρχείο θέσης κοπτικού από τις ακολουθίες αριθμητικού 
ελέγχου που έχουν κατασκευαστεί. Για αυτό το σκοπό επιλέγεται στο menu manager CL 
Data. Στη συνέχεια εξάγεται το αρχείο θέσης κοπτικού, είτε για όλη την λειτουργία, είτε για 
κάποιες ακολουθίες. Επιλέγεται λοιπόν Output→ Select one→ Operation→ Op010. 
 
Στη συνέχεια επιλέγει ο χρήστης να εξάγει το αρχείο θέσης κοπτικού σε αρχείο και σε ποιο 
φάκελο θα αποθηκευτεί. Επιλέγεται ο φάκελος εργασίας και στη συνεχεία ΟΚ. Εάν το αρχείο 
δημιουργήθηκε επιτυχώς ή όχι εμφανίζεται στο κάτω μέρος της οθόνης. Εάν έχει 
δημιουργηθεί επιλέγεται done output. Για να εκτελεστεί η τελική επεξεργασία του αρχείου 
θέσης κοπτικού επιλέγεται  στο menu manager CL Data→ Post process και επιλέγεται το 
αρχείο που δημιουργήθηκε στο προηγούμενο βήμα. Με την επιλογή αυτή εμφανίζονται στο 
menu manager όλοι οι τελικοί επεξεργαστές που είναι διαθέσιμοι. 
 
Επιλέγεται ο UNCX01.P72, ο οποίος είναι ο κατάλληλος για την κατεργασία του τεμαχίου και 
στη γραμμή εντολών που εμφανίζεται γράφεται το όνομα του προγράμματος. Σε αυτό το 
σημείο εμφανίζεται ένα παράθυρο που δίνει πληροφορίες για την ολοκληρωμένη διαδικασία. 
Το αρχείο με τον κώδικα της εργαλειομηχανής έχει αποθηκευτεί στο φάκελο που βρίσκεται 
και το αρχείο θέσης κοπτικού. Το συγκεκριμένο αρχείο είναι έτοιμο να αποσταλεί στην 
εργαλειομηχανή και να αρχίσει η πραγματική κατεργασία. 
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Σχήμα 4.18: Τελικό τεμάχιο στο Vericut. 
 
 
4.2 Δεύτερο Τεμάχιο  
 
Αρχικά δημιουργείται το μοντέλο κατεργασίας. Το τελικό τεμάχιο έχει σχεδιαστεί στο Pro-
Engineer (σχήμα 4.19).  
 

 
Σχήμα 4.19: Πρότυπο τεμάχιο 2. 
 
Στο παράθυρο που θα εμφανιστεί, εισάγεται η περίσσεια υλικού σε κάθε διάσταση του 
ακατέργαστου κομματιού, όπως φαίνεται παρακάτω: 
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Σχήμα 4.20: Περίσσεια υλικού σε κάθε διάσταση. 
 
Το τελικό μοντέλο κατεργασίας δημιουργήθηκε με τη διαδικασία που παρουσιάστηκε στο 
τεμάχιο 1 και  φαίνεται στο σχήμα 4.21. 
 

 
Σχήμα 4.21: Τελικό μοντέλο κατεργασίας τεμαχίου 2. 
 
Στη συνέχεια δημιουργείται το περιβάλλον κατεργασιών και εισάγεται το μοντέλο 
κατεργασίας, στο οποίο ορίζεται και σύστημα συντεταγμένων. 
 
Τώρα ορίζεται μία νέα λειτουργία. Δηλώνεται ως Machine Zero το σύστημα συντεταγμένων 
του τεμαχίου και η  επιφάνεια επιστροφής (retract surface) επιλέγεται και πάλι κατά μήκος 
του άξονα z με βάθος 5. Στη συνέχεια ορίζεται μία μηχανή αριθμητικού ελέγχου με τις 
παραμέτρους της προηγούμενης. Το επόμενο βήμα είναι η δημιουργία της λίστας των 
κοπτικών εργαλείων που θα χρησιμοποιηθούν. Τα κοπτικά που χρησιμοποιήθηκαν είναι τρία 
κονδύλια και ένα σφαιρικής απόληξης, διαμέτρου 10, 20 ,5 και 10 mm αντίστοιχα. (σχήμα 
4.22) 
 
Σε αυτό το σημείο αρχίζει η εικονική κατεργασία του τεμαχίου, αφαιρώντας την περίσσεια 
υλικού που βρίσκεται στο άνω μέρος του με μία ακολουθία προσώπου (Face). Επιλέγεται το 
κονδύλι των 20mm. Το επόμενο βήμα είναι ο ορισμός των παραμέτρων της κατεργασίας. 
Εκτός των παραμέτρων του σχήματος 4.23 πρέπει να επιλεγεί «Yes» στο Trim to workpiece, 
που εμφανίζεται πατώντας Advanced.  
 
Η πορεία του κοπτικού φαίνεται στο σχήμα 4.24 και η κατεργασία έχει ολοκληρωθεί. 
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Σχήμα 4.22: Ορισμός κοπτικών εργαλείων. 
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Σχήμα 4.23: Τιμές των παραμέτρων της κατεργασίας προσώπου. 
 

 
Σχήμα 4.24: Πορεία κοπτικού για την κατεργασία προσώπου. 
 
Η επόμενη ακολουθία είναι κατεργασία όγκου. Για την δημιουργία του επιλέγεται Machining→ 
Nc Sequence→ New Sequence→ Volume→ Done. Επιλέγεται το κονδύλι των 5mm. 
Πατώντας Set ορίζονται οι παράμετροι της κατεργασίας (Σχήμα 4.25).  
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Σχήμα 4.25: Τιμές των παραμέτρων της πρώτης κατεργασίας όγκου.  
 
Στη συνέχεια πρέπει να δημιουργηθεί ο προς κατεργασία όγκος πατώντας Create volume και 
Gather→ Select→ Done→ Surf & bnd→ Done. Με αυτό τον τρόπο επιλέγει ο χρήστης όλες 
τις επιφάνειες που περικλείουν τον όγκο, αφού έχει πατηθεί  hide στο workpiece του Model 
Tree. (σχήμα 4.26)  
 

 
Σχήμα 4.26: Επιλεγμένος όγκος. 
 
Μετά από συνεχή done, επιλέγεται unhide στο workpiece του Model Tree και play path. Η 
πορεία του κοπτικού φαίνεται στο σχήμα 4.27.  
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Σχήμα 4.27: Πορεία κοπτικού για την πρώτη κατεργασία όγκου. 
 
Το επόμενο βήμα είναι η αφαίρεση του κατεργασμένου όγκου πατώντας Matrl Remove→ 
automatic→ done→ auto add→ ok→ done. (σχήμα 4.28) 
 

 
Σχήμα 4.28: Αφαίρεση κατεργασμένου όγκου. 
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Η επόμενη ακολουθία είναι επίσης κατεργασία όγκου. Για την δημιουργία του επιλέγεται 
Machining→ Nc Sequence→ New Sequence→ Volume→ Done. Επιλέγεται ως κοπτικό το 
κονδύλι των 5mm. Στο παράθυρο που εμφανίζεται επιλέγεται Window→ Done→ Create 
Wind→ Sketch και αυτόματα δημιουργείται ένα sketch, στο οποίο ο χρήστης σχεδιάζει το 
παράθυρο που θα κινηθεί το κοπτικό. Στο συγκεκριμένο παράδειγμα, το παράθυρο φαίνεται 
στο σχήμα 4.29. Πατώντας Set ορίζονται οι παράμετροι της κατεργασίας (σχήμα 4.30).  
 

 
Σχήμα 4.29: Σχέδιο του παραθύρου εντός του οποίου θα κινηθεί το κοπτικό. 
 

 
Σχήμα 4.30: Τιμές των παραμέτρων της δεύτερης κατεργασίας όγκου.  
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Στο σχήμα 4.31 φαίνεται η πορεία που θα ακολουθήσει το κοπτικό εργαλείο για τη 
συγκεκριμένη κατεργασία όγκου και στο σχήμα 4.32 η αφαίρεση αυτού του όγκου. 
 

 
Σχήμα 4.31: Πορεία κοπτικού για την δεύτερη κατεργασία όγκου. 
 

 
Σχήμα 4.32: Αφαίρεση κατεργασμένου όγκου. 
 
Η επόμενη ακολουθία είναι πάλι κατεργασία όγκου. Επιλέγεται και πάλι το κονδύλι των 5mm. 
Πατώντας Set ορίζονται οι παράμετροι της κατεργασίας (σχήμα 4.33). Στη συνέχεια 
επιλέγεται ο όγκος προς κατεργασία, ο οποίος φαίνεται στο σχήμα 4.34 με κόκκινο χρώμα. 
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Σχήμα 4.33: Τιμές των παραμέτρων της τρίτης κατεργασίας όγκου.  
 

 
Σχήμα 4.34: Επιλεγμένος όγκος. 
 
 
Στο σχήμα 4.35 φαίνεται η πορεία που θα ακολουθήσει το κοπτικό εργαλείο για τη 
συγκεκριμένη κατεργασία όγκου και στο σχήμα 4.36 η αφαίρεση αυτού του όγκου. 
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Σχήμα 4.35: Πορεία κοπτικού για την τρίτη κατεργασία όγκου. 
 

 
Σχήμα 4.36: Αφαίρεση κατεργασμένου όγκου. 
 
Για την επόμενη κατεργασία όγκου χρησιμοποιείται και πάλι το κοπτικό των 5mm. Το 
παράθυρο μέσα στο οποίο θα κινηθεί το κοπτικό φαίνεται στο σχήμα 4.37 και οι τιμές των 
παραμέτρων της κατεργασίας στο σχήμα 4.38.  
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Σχήμα 4.37: Σχέδιο του παραθύρου εντός του οποίου θα κινηθεί το κοπτικό. 
 

 
Σχήμα 4.38: Τιμές των παραμέτρων της τέταρτης κατεργασίας όγκου. 
 
Στο σχήμα 4.39 φαίνεται η πορεία που θα ακολουθήσει το κοπτικό εργαλείο για τη 
συγκεκριμένη κατεργασία όγκου.  
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Σχήμα 4.39: Πορεία κοπτικού για την τέταρτη κατεργασία όγκου. 
 
Στη συνέχεια δημιουργείται μία κατεργασία surface milling ομοίως με τη κατεργασία όγκου, 
επιλέγοντας το ίδιο παράθυρο και τις ίδιες παραμέτρους αλλά με το ball κοπτικό. Στο σχήμα 
4.40 φαίνεται η πορεία του κοπτικού. 
 

 
Σχήμα 4.40: Πορεία κοπτικού για το ξεχόνδρισμα της επιφάνειας με surface milling. 
 
Το επόμενο βήμα είναι μία κατεργασία αποπεράτωσης της ίδιας επιφάνειας, της οποίας οι 
παράμετροι φαίνονται στο σχήμα 4.41. Στο σχήμα 4.42 φαίνεται η πορεία που θα 
ακολουθήσει το κοπτικό και στο σχήμα 4.43 η τελική μορφή του τεμαχίου. 
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Σχήμα 4.41: Παράμετροι της κατεργασίας αποπεράτωσης της επιφάνειας. 
 

 
Σχήμα 4.42: Πορεία κοπτικού για την αποπεράτωση της επιφάνειας με surface milling. 
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Σχήμα 4.43: Τεμάχιο μετά το τέλος  των κατεργασιών της παραπάνω επιφάνειας.  
 
Για την επόμενη κατεργασία όγκου χρησιμοποιείται και πάλι το κοπτικό των 5mm. Το 
παράθυρο μέσα στο οποίο θα κινηθεί το κοπτικό φαίνεται στο σχήμα 4.44 και οι τιμές των 
παραμέτρων της κατεργασίας στο σχήμα 4.45.  
 

 
Σχήμα 4.44: Σχέδιο του παραθύρου εντός του οποίου θα κινηθεί το κοπτικό. 
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Σχήμα 4.45: Τιμές των παραμέτρων της πέμπτης κατεργασίας όγκου. 
 
Στο σχήμα 4.46 φαίνεται η πορεία που θα ακολουθήσει το κοπτικό για τη συγκεκριμένη 
κατεργασία όγκου.  
 

 
Σχήμα 4.46: Πορεία κοπτικού για την πέμπτη κατεργασία όγκου. 
 
Στη συνέχεια δημιουργούνται άλλες δύο κατεργασίες surface milling ομοίως με αυτές που 
παρουσιάστηκαν παραπάνω, επιλέγοντας το παράθυρο και τις παραμέτρους της πέμπτης 
κατεργασίας όγκου, αλλά με το ball κοπτικό. Στο σχήμα 4.47 φαίνεται η πορεία του κοπτικού 
για την πρώτη, στο σχήμα 4.49 για τη δεύτερη και στο σχήμα 4.48 οι παράμετροί της.  
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Σχήμα 4.47: Πορεία κοπτικού για το ξεχόνδρισμα της επιφάνειας με surface milling. 
 

 
Σχήμα 4.48: Παράμετροι της κατεργασίας αποπεράτωσης της επιφάνειας. 
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Σχήμα 4.49: Πορεία κοπτικού για την αποπεράτωση της επιφάνειας με surface milling. 
 
Στο σχήμα 4.50 φαίνεται το τεμάχιο μετά την αφαίρεση του υλικού και στο σχήμα 4.51 το 
τελικό τεμάχιο στο πρόγραμμα προσομοίωσης Vericut. 
 

 
Σχήμα 4.50: Τεμάχιο μετά το τέλος  των κατεργασιών της παραπάνω επιφάνειας.  
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Σχήμα 4.51: Τελικό τεμάχιο στο Vericut. 
 
 
4.3 Τρίτο Τεμάχιο  
 
Αρχικά δημιουργείται το μοντέλο κατεργασίας. Το τελικό τεμάχιο έχει σχεδιαστεί στο Pro-
Engineer (σχήμα 4.52).  
 

 
Σχήμα 4.52: Πρότυπο τεμάχιο 3. 
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Στο παράθυρο που θα εμφανιστεί, εισάγεται η περίσσεια υλικού σε κάθε διάσταση του 
ακατέργαστου κομματιού, όπως φαίνεται παρακάτω: 
 

 
Σχήμα 4.53: Περίσσεια υλικού σε κάθε διάσταση. 
 
Το τελικό μοντέλο κατεργασίας δημιουργήθηκε με τη διαδικασία που παρουσιάστηκε στο 
τεμάχιο 1 και  φαίνεται στο σχήμα 4.54. 
 

Σχήμα 4.54: Τελικό μοντέλο κατεργασίας τεμαχίου 3. 
 
Στη συνέχεια δημιουργείται το περιβάλλον κατεργασιών και εισάγεται το μοντέλο 
κατεργασίας, στο οποίο ορίζεται και σύστημα συντεταγμένων. 
 
Τώρα ορίζεται μία νέα λειτουργία. Δηλώνεται ως Machine Zero το σύστημα συντεταγμένων 
του τεμαχίου και η  επιφάνεια επιστροφής (retract surface) επιλέγεται και πάλι κατά μήκος 
του άξονα z με βάθος 5. Στη συνέχεια ορίζεται η ίδια μηχανή αριθμητικού ελέγχου. Το 
επόμενο βήμα είναι η δημιουργία της λίστας των κοπτικών εργαλείων που θα 
χρησιμοποιηθούν. Τα κοπτικά που χρησιμοποιήθηκαν είναι τέσσερα κονδύλια, διαμέτρων 20, 
15 ,10 και 8 mm αντίστοιχα. (σχήμα 4.55) 
 
Σε αυτό το σημείο αρχίζει η εικονική κατεργασία του τεμαχίου, αφαιρώντας την περίσσεια 
υλικού που βρίσκεται στο άνω μέρος του με μία ακολουθία προσώπου (Face). Επιλέγεται το 
κονδύλι των 20mm. Το επόμενο βήμα είναι ο ορισμός των παραμέτρων της κατεργασίας. 
Εκτός των παραμέτρων του σχήματος 4.56 πρέπει και πάλι να επιλεγεί «Yes» στο Trim to 
workpiece. 
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Η πορεία του κοπτικού φαίνεται στο σχήμα 4.57 και η κατεργασία έχει ολοκληρωθεί 
αφαιρώντας και τον κατεργασμένο όγκο. 
 

 
Σχήμα 4.55: Ορισμός κοπτικών εργαλείων. 
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Σχήμα 4.56: Τιμές των παραμέτρων της κατεργασίας προσώπου. 
 

 
Σχήμα 4.57: Πορεία κοπτικού για την κατεργασία προσώπου. 
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Η επόμενη ακολουθία είναι μία κατεργασία περιγράμματος. Επιλέγεται και πάλι το κονδύλι 
των 20mm. Οι παράμετροι της κατεργασίας φαίνονται στο σχήμα 4.58 και από το μενού 
Advanced το num prof passes γίνεται 2 και το prof increment 4. Στο σχήμα 4.59 
παρουσιάζεται η πορεία του κοπτικου για την κατεργασία του περιγράμματος και στο σχήμα 
4.60 φαίνεται το τεμάχιο μετά το τέλος της κατεργασίας. 
 

 
Σχήμα 4.58: Τιμές των παραμέτρων της κατεργασίας περιγράμματος. 
 

 
Σχήμα 4.59: Πορεία κοπτικού για την κατεργασία περιγράμματος. 
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Σχήμα 4.60: Αφαίρεση κατεργασμένου όγκου. 
 
Στη συνέχεια δημιουργείται μια κατεργασία τροχιάς επιλέγοντας Machining→ Nc Sequence→ 
New Sequence→ Trajectory→ Done. Επιλέγεται το κονδύλι των 15mm. Οι παράμετροι της 
κατεργασίας φαίνονται στο σχήμα 4.61. Μετά τον ορισμό των παραμέτρων εμφανίζονται τα 
παράθυρα του σχήματος 4.62, όπου επιλέγεται το Edge αντί του Sketch. Μετά επιλέγεται η 
ακμή, η οποία θα χρησιμοποιηθεί για τη δημιουργία της τροχιάς. (σχήμα 4.63) 
 

 
Σχήμα 4.61: Τιμές των παραμέτρων της κατεργασίας τροχιάς.  
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Σχήμα 4.62: Δημιουργία κατεργασίας τροχιάς. 
 

 
Σχήμα 4.63: Επιλογή τροχιάς. 
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Στη συνέχεια επιλέγεται η κατεύθυνση κοπής του εργαλείου, καθώς και η φορά μετατόπισής 
του. Στο σχήμα 4.64 φαίνεται η πορεία που θα ακολουθήσει το κοπτικό. 
 

 
Σχήμα 4.64: Πορεία κοπτικού για την πρώτη κατεργασία τροχιάς. 
 
Ακριβώς με τον ίδιο τρόπο δημιουργείται η κοπή στο αριστερό μέρος του τεμαχίου και μετά 
την αφαίρεση των δύο όγκων η εικόνα του παρουσιάζεται στο σχήμα 4.65. 
 

 
Σχήμα 4.65: Τεμάχιο μετά τις κατεργασίες τροχιάς. 
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Η επόμενη ακολουθία είναι κατεργασία όγκου. Επιλέγεται το κονδύλι των 15mm. Πατώντας 
Set ορίζονται οι παράμετροι της κατεργασίας (σχήμα 4.66).  
 

 
Σχήμα 4.66: Τιμές των παραμέτρων της κατεργασίας όγκου.  
 

 
Σχήμα 4.67: Πορεία κοπτικού για την κατεργασία όγκου.  
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Στη συνέχεια δημιουργείται μια κατεργασία διάτρησης επιλέγοντας Machining→ Nc 
Sequence→ New Sequence→ Holemaking→ Done→ Drill→ Standard→ Done. Επιλέγεται 
το κονδύλι των 10mm. Οι παράμετροι της κατεργασίας φαίνονται στο σχήμα 4.68. Μετά τον 
ορισμό των παραμέτρων εμφανίζονται τα παράθυρα του σχήματος 4.69, όπου επιλέγεται το 
Pattern αντί του Single. Μετά επιλέγεται το κάτω τόξο του κυλίνδρου που σχηματίζεται η οπή. 
Η πορεία του κοπτικού μετά το τέλος της κατεργασίας φαίνεται στο σχήμα 4.70. 
 

 
Σχήμα 4.68: Τιμές των παραμέτρων της κατεργασίας διάτρησης.  
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Σχήμα 4.69: Δημιουργία κατεργασίας διάτρησης. 
 

 
Σχήμα 4.70: Πορεία κοπτικού για την κατεργασία διάτρησης. 
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Με τον ίδιο ακριβώς τρόπο δημιουργείται άλλη μία κατεργασία διάτρησης με τις ίδιες 
παραμέτρους και το κονδύλι των 8 mm για την κατεργασία της οπής από το σημείο που 
τελείωσε η προηγούμενη μέχρι το επιθυμητό βάθος. Η πορεία του κοπτικού εργαλείου 
φαίνεται στο σχήμα 4.71. 
 

 
Σχήμα 4.71: Πορεία κοπτικού για τη δεύτερη κατεργασία διάτρησης. 
 
Σε αυτό το σημείο έχει ολοκληρωθεί η κατεργασία του τεμαχίου και αποτέλεσμα 
παρουσιάζεται στο σχήμα 4.72 μέσω του στο προγράμματος προσομοίωσης Vericut. 
 

 
Σχήμα 4.72: Τελικό τεμάχιο στο Vericut. 
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4.4 Τέταρτο Τεμάχιο  
 

 
Σχήμα 4.73: Πρότυπο τεμάχιο 4. 
 
Το συγκεκριμένο αντικείμενο είναι μοντέλο του Inventor και εισήχθη στο Pro/Manufacture σε 
μορφή step με σκοπό την εκμετάλλευση της δυνατότητας του προγράμματος να κατεργαστεί 
εισηγμένες γεωμετρίες από άλλα προγράμματα CAD. 
 
Στη συνέχεια δημιουργείται και πάλι το περιβάλλον κατεργασιών και εισάγεται το μοντέλο 
κατεργασίας, στο οποίο ορίζεται και σύστημα συντεταγμένων. Επίσης εισάγεται η περίσσεια 
υλικού σε κάθε διάσταση του ακατέργαστου κομματιού, όπως φαίνεται παρακάτω: 
 

 
Σχήμα 4.74: Περίσσεια υλικού σε κάθε διάσταση. 
 
Το τελικό μοντέλο κατεργασίας δημιουργήθηκε με τη διαδικασία που παρουσιάστηκε στο 
τεμάχιο 1 και  φαίνεται στο σχήμα 4.75. 
 

 
Σχήμα 4.75: Τελικό μοντέλο κατεργασίας τεμαχίου 4. 
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Τώρα ορίζεται μία νέα λειτουργία. Δηλώνεται ως Machine Zero το σύστημα συντεταγμένων 
του τεμαχίου και η  επιφάνεια επιστροφής (retract surface) επιλέγεται και πάλι κατά μήκος 
του άξονα z με βάθος 5. Στη συνέχεια ορίζεται η ίδια μηχανή αριθμητικού ελέγχου. Το 
επόμενο βήμα είναι η δημιουργία της λίστας των κοπτικών εργαλείων που θα 
χρησιμοποιηθούν. Τα κοπτικά που χρησιμοποιήθηκαν είναι τρία κονδύλια, διαμέτρων 20, 10 
και 2 mm αντίστοιχα (σχήμα 4.78) 
 
Σε αυτό το σημείο αρχίζει η εικονική κατεργασία του τεμαχίου, χρησιμοποιώντας την 
ακολουθία κατεργασίας εκχόνδρισης. Επιλέγεται το κονδύλι των 20mm. Οι παράμετροι της 
κατεργασίας φαίνονται στο σχήμα 4.76 και η επιλογή του παραθύρου μέσα στο οποίο θα 
κινηθεί το κοπτικό στο σχήμα 4.77. Τέλος η πορεία του κοπτικού φαίνεται στα σχήματα 4.79 
και 4.80. 
 

 
Σχήμα 4.76: Τιμές των παραμέτρων της κατεργασίας εκχόνδρισης. 
 

 
Σχήμα 4.77: Ορισμός του παραθύρου κατεργασίας. 



58 
 

 
Σχήμα 4.78: Ορισμός κοπτικών εργαλείων. 
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Σχήμα 4.79: Μέρος της πορείας του κοπτικού για την κατεργασία εκχόνδρισης. 
 

 
 

Σχήμα 4.80: Πορεία του κοπτικού για την κατεργασία εκχόνδρισης στο Vericut. 
 
Η επόμενη ακολουθία είναι κατεργασία αποπεράτωσης. Επιλέγεται το κονδύλι των 10mm. 
Πατώντας Set ορίζονται οι παράμετροι της κατεργασίας (σχήμα 4.81). Η πορεία του κοπτικού 
φαίνεται στα σχήματα 4.82 και 4.83. 
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Σχήμα 4.81: Τιμές των παραμέτρων της πρώτης κατεργασίας αποπεράτωσης. 
 

 
Σχήμα 4.82: Μέρος της πορείας του κοπτικού για την πρώτη κατεργασία αποπεράτωσης. 
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Σχήμα 4.83: Πορεία του κοπτικού για την πρώτη κατεργασία αποπεράτωσης στο Vericut. 
 
Η επόμενη ακολουθία είναι άλλη μία κατεργασία αποπεράτωσης. Επιλέγεται το κονδύλι των 
2mm. Οι παράμετροι της κατεργασίας φαίνονται στο σχήμα 4.84. Στο σχήμα 4.85 φαίνεται το 
τελικό τεμάχιο στο πρόγραμμα προσομοίωσης Vericut. 
 

 
Σχήμα 4.84: Τιμές των παραμέτρων της δεύτερης κατεργασίας αποπεράτωσης. 
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Σχήμα 4.85: Τελικό τεμάχιο στο Vericut. 
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5. Συμπεράσματα- Αποτελέσματα 
 
Στη παρούσα διπλωματική εργασία μελετήθηκε ο αυτόματος τρόπος δημιουργίας κώδικα 
εργαλειομηχανών. Παρουσιάστηκε εκτενώς η μεθοδολογία με βάση την οποία γίνεται η 
αυτόματη δημιουργία του κώδικα με την βοήθεια του Pro/Engineer. Η μεθοδολογία αυτή 
χρησιμοποιήθηκε στη δημιουργία τεσσάρων δοκιμιών. 
 
Κατά την διάρκεια τόσο του σχεδιασμού τους όσο και της κατασκευής τους έγιναν οι εξής 
παρατηρήσεις: 
 
Πριν τον σχεδιασμό των κατεργασιών πρέπει: 

• Να λαμβάνεται υπόψη ο τρόπος συγκράτησης του εκάστοτε κομματιού με το τραπέζι 
της εργαλειομηχανής. 

• Να είναι γνωστά τα κοπτικά εργαλεία με τα οποία θα γίνει η κατεργασία. Αυτά τα 
εργαλεία πρέπει να ικανοποιούν τις γεωμετρικές απαιτήσεις του τεμαχίου. 

• Να αφιερωθεί χρόνος για την καταγραφή της σειράς με την οποία θα εκτελεστούν οι 
κατεργασίες και των υποδομών που θα δημιουργηθούν για περεταίρω κατεργασίες 
(π.χ. αποπεράτωση). 

 
Κατά τη διάρκεια του σχεδιασμού των κατεργασιών πρέπει: 

• Να λαμβάνονται υπόψη οι αντοχές των κοπτικών, καθώς και οι ιδιαιτερότητες της 
εκάστοτε μηχανής. 

• Να εισάγονται στο πρόγραμμα σχόλια για τη διευκόλυνση του χειριστή της 
εργαλειομηχανής. 

• Να γίνεται προσομοίωση του κώδικα σε ειδικό πρόγραμμα για την ανίχνευση λαθών 
του προγράμματος και τη βελτίωση της πορείας του κοπτικού. 

• Να λαμβάνεται υπόψιν το γεγονός ότι μπορεί το αντικείμενο προς κατεργασία να έχει 
απόκλιση στο μέγεθος από το επιθυμητό. 

 
Για τη μείωση του χρόνου κατεργασίας πρέπει να χρησιμοποιούνται εργαλεία με μεγάλες 
διαμέτρους κυρίως στα στάδια της εκχόνδρισης. 
Τα υλικά κατασκευής των κοπτικών πρέπει να είναι τέτοια ώστε να επιτρέπουν όσο το 
δυνατόν μεγαλύτερα βάθη και πλάτη κοπής καθώς και μεγάλες ταχύτητες πρόωσης. 
Τα υγρά κοπής πρέπει να χρησιμοποιούνται ώστε να αυξήσουν την διάρκεια ζωής των 
εργαλείων και να επιτρέψουν μεγαλύτερα βάθη και πλάτη κοπής και μεγαλύτερες προώσεις. 
 
Η χρήση προγραμμάτων CAD-CAM για το σχεδιασμό των τεσσάρων τεμαχίων θεωρείται 
απαραίτητη λόγω της έκτασης του κώδικα (ειδικά στο 4ο τεμάχιο), η οποία ήταν τόσο μεγάλη 
που καθιστά απαγορευτική την προσπάθεια για χειρονακτικό προγραμματισμό.  
 
Στον παρακάτω πίνακα φαίνεται η έκταση του κώδικα για κάθε τεμάχιο, καθώς και οι 
αντίστοιχοι χρόνοι κατεργασίας, που για τα δύο πρώτα τεμάχια που κόπηκαν αντιστοιχούν 
στους πραγματικούς. 
 

Τεμάχιο  Γραμμές Κώδικα Χρόνος Κατεργασίας  

1  260  21 min  

2  24.256  65 min  

3  204  23 min  

4  320.651  2000 min  
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Παρακάτω παρουσιάζονται φωτογραφίες των τεμαχίων που κόπηκαν. 
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